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Introduction To Premium Attendant

Premium Attendant is a self-managed automated attendant receptionist service 
allowing you to configure a flexible set of TUI menus for callers to your business. When 
turned on, it answers your calls automatically, and offers your callers a list of options 
(a “menu”) that you define. You can allow your callers to listen to messages (such as 
your opening times) , to leave a message, or to be transferred to a real person. For 
example:

Welcome to Bob’s Tires. We are open for business right now. To hear directions to our 
store, press 1. To hear our opening hours, press 2. If you know the extension of the 
person you require, press 3. If you know the name of the person you require, press 4 
, and then enter their name followed by the pound key. Or, for any other enquiries 
please press 0.

You can create different menus for different times of the day and week that play 
according to the pre-defined schedules that you have created.

Welcome to Bob’s Tires. Unfortunately we are currently closed. To hear directions to 
our store, press 1. To hear our opening hours, press 2. If you wish to leave a message, 
press 3, and we will get back to you as soon as possible.

Once you have set up Premium Attendant with these schedules and menus and 
recorded the necessary announcements, it will automatically play callers the correct 
menu depending on when they call.

Setting up Premium Attendant For The First Time

You may find it helpful to map your Premium Attendant menu and schedule period 
structure out on paper first, particularly if you will have several schedule periods and 
complex menu options. You should refer to Working with the Premium Attendant 
interface for a description of the common behavior of aspects of this interface. 

To set up your Premium Attendant, you should take the following steps.

Step 1 - Configure your Premium Attendant schedule periods by going to the Schedule 
tab and adding new periods.

Step 2 - Optionally, Configure a number to forward callers to whilst your Premium 
Attendant is turned off. If you skip this step, then until you have finished setting up the 
service, callers to your Premium Attendant will be played a message saying that the 
number is unreachable.

Step 3 - Configure the menus that you wish to offer your callers during the different 
schedule periods that you have just created.

Step 4 - Record the announcements that your caller will hear for the menu options 
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that require them.

Step 5 - If (in Step 3) you chose to offer the option to use Dial by Extension, Dial by 
Name, Voicemail by Extension, Voicemail by Name or Selfcare by Extension, configure 
the extensions your callers can dial.

Step 6 - Use the Advanced Settings tab if you wish to change the default settings for 
the keys used in your menus or the way in which Premium Attendant handles caller 
error.

Step 7 - Turn on Premium Attendant.

Working With The Premium Attendant Interface

The Schedule, Menus and Announcements tabs in the Premium Attendant interface 
have a yellow introduction-style panel that you will see the first time you access the 
tab. This outlines the basic tasks that you need to undertake under this tab to set 
up your Premium Attendant. On the Schedule tab, this is the only time you will be 
able to see this information - as soon as you save something on the page, it is not 
possible to return to seeing the first time hint. On the Menus and Announcements 
tabs you will continue to see the introductory panel whenever you delete the last 
menu or announcement. The Extensions tab displays helpful information on setting up 
extensions whenever there are no extensions.

The following principles apply to working with the pages under the Schedule, Menus, 
Announcements and Extensions tabs.

• If there are existing items already created, then on first visiting each of these pages
 ◦ if the link from the main tab is used, the current opening menu is selected, 

otherwise the first item alphabetically is selected
 ◦ the buttons ‘Add ...’ and ‘Delete ...’ are enabled.
 ◦ clicking on ‘Add ...’ brings up an empty configuration allowing you to create a 

new schedule, menu, announcement or extension.
 ◦ where present, the search box can be used to find an existing item by typing 

in...
 ▪ all or part of the name on the Schedule and Menus tab.
 ▪ all or part of the id, name or description on the Announcements tab.
 ▪ all or part of the extension number, name or description on the Extensions 

tab.
• As soon as you make an edit on a page...

 ◦ ‘Apply’ and ‘Cancel’ become enabled.
 ◦ ‘Add ...’ and ‘Delete ...’ become disabled.
 ◦ the search box becomes grayed out and unusable.
 ◦ any attempt to switch menus, or navigate to another tab without applying 

or cancelling your changes, results in a pop-up warning you that there are 
uncommitted changes on the current tab.
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Names & Descriptions

Each element of Premium Attendant (schedules, menus, announcements, recordings) 
has a name and description, that you will be prompted to enter in a pop-up overlay 
that appears once any ‘Add new’ button is pressed.

• Name can be up to 40 characters long. The name can be changed later. 
Changing the name causes the links between menus to be automatically 
updated. The name of each element must be unique.

• Description can be up to 256 characters long. The description can subsequently 
be edited.

• The name and description is not committed on clicking “OK” to close the pop-up 
after entering the required text, but is committed when you press ‘Apply’ on the 
main page.

• Hovering over an item once it is selected shows a tooltip of its name or description.

Error Icons

The Premium Attendant interface uses the following error messages and icons to alert 
you to incorrect or missing configuration. These are produced on page load, and are 
not updated dynamically.

• The Main tab has a Service Status panel that states your current schedule period 
and the menu that callers will hear. It also reports if you have errors in any menus, 
or one or more announcements is missing audio.

• The Schedule and Menus pages use a banner line to report any errors.
• The following icons are used to indicate incorrect or incomplete configuration...

 ◦    error icon
 ◦    warning icon

If there are any errors in your configuration, you will be warned against turning on 
Premium Attendant, and in some cases this will be prohibited.

Configuring Your Premium Attendant Schedule Periods

You can configure up to eight Premium Attendant schedule periods, for example 
you might create one schedule for your normal business hours, a second schedule to 
cover the lunch period and an out of hours schedule for when your business is closed. 
You can create a separate menu for each of the schedules that you define.

To create a new schedule:

• If this is the first time you have opened the Schedule tab, you can click on the links 
to either use a blank schedule or an example schedule as the basis for your new 
schedule. At all other times, use the ‘Add new period’ button to create a new 
schedule. You will see a warning pop-up if you attempt to add a new period once 
you have configured the maximum number of schedule periods.
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• You will be prompted to give the new schedule a unique name, and a description.
• For each schedule that you create, you should configure the hours, for each day 

from Monday to Sunday, when this schedule should apply. You do this by “coloring 
in” the grid by clicking on the appropriate cells. You can change several cells at 
once by clicking and dragging. Each schedule period is shown in a different color.

• Each schedule must have an associated opening menu before you can turn 
your Premium Attendant on. You can either choose an existing menu from the 
dropdown list or use the ‘create new menu’ option to add a new one.
 ◦ If you select ‘create new menu’ you will then be prompted to enter a 

unique name and a description for the menu. You can only use this option 
if your Premium Attendant is turned off. You will configure this menu and its 
announcements later in the set-up process.

Once you have created them, these schedules are shown in alphabetical order in the 
Periods panel on the Schedules tab. If there are any errors in any of these schedules, 
you will see a       icon alongside the schedule name. You can subsequently edit a 
schedule by selecting it, making your required changes, and then clicking on the 
Apply button to save your updated schedule.

There are two schedule periods already created in this list to cover ‘at all other times’ 
and ‘special days’.

• The ‘all other times’ schedule is used at the times that are not defined in any of 
your other schedules. This schedule is always the penultimate schedule in the list, 
and is colored in white.

• The Special days schedule covers public holidays and other special one-off days 
when your business is closed. This schedule is always the last schedule in the list, 
and is colored in black.
 ◦ You should select this schedule and use the calendar to configure any special 

one-off dates to be included in this schedule.
 ◦ If you always close on public holidays, you can easily select all of the public 

holidays for your locale by clicking on the ‘Add public holidays’ button.
 ◦ When you have finished editing the schedule, press ‘Apply’ to save your  

changes.

On first use, these schedules will be shown as having errors until you have specified the 
opening menu that you wish to associate with each of these schedules. You will not be 
able to turn Premium Attendant on until you have selected these menus and created 
the necessary announcements. These two schedules cannot be deleted or renamed.

Switching Between Schedule Periods

If your Premium Attendant is turned on, you can only switch from one period to 
another if the currently selected period has no errors in its menu selection.
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Configuring Your Premium Attendant Menu(s)

Your Premium Attendant menu configuration determines what options your callers are 
offered, and what announcements they hear.

The following instructions describe how to set up and edit your Premium Attendant 
menus. You will need to repeat these steps for each of the menus that you need to 
create. From the Menu page, you should use the following tabs to set up and edit 
your Premium Attendant menus. The list of existing menus will always be visible in the 
left-hand panel of the screen - you should ensure that you have the correct menu 
selected before making any changes using the following tabs.

Step 1 - Use the General tab to add a new menu, or edit or delete a menu once you 
have selected it in the list on the left-hand side of the page.

Step 2 - Use the Keys tab to assign actions to the keys that a caller can press to 
navigate the menu.

Step 3 - Use the Timeout tab if you wish to override the default timeout behavior for this 
menu.

Step 4 - If you are editing or deleting an existing menu, use the Reference tab if you 
want to see if any other menus or periods make reference to this menu.

General Tab

Use the General tab to configure the menus to be associated with different schedule 
periods. Existing menus are listed on the left-hand side of the screen, and an icon 
will be shown alongside any menus that have errors. The General tab will display a 
message if a selected menu has errors or warnings and all menus that contain errors or 
warnings will have an icon alongside their name indicating this. These will be dismissed 
once these errors are fixed or the warnings resolved, and ‘Apply’ has been pressed to 
save the changes.

• Navigate to the General tab by clicking on the Menu tab in Premium Attendant.
• To add a new menu, click on the Add new menu button.

 ◦ You will then be prompted to add a unique name and a description for this 
menu.

 ◦ You must specify the menu announcement to be used for this menu using the 
drop-down box. You can either choose an existing menu announcement or opt 
to create a new one for this menu. You will record this announcement later in 
the set-up process.

• To edit an existing menu, you should select the menu that you want to edit from 
the list on the left-hand side of the page.
 ◦ The menu list in the left hand panel can be up to 150 menus long, so you can 

use the Search facility to enter part or all of the name to find the menu you wish 
to edit more easily.
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• To delete a menu, select the menu from the list on the left-hand side, and click the 
Delete button.
 ◦ You will see a pop-up asking for confirmation that you wish to delete it.
 ◦ You will also see a pop-up warning if this menu is referenced by another menu 

or period.
 ◦ If your Premium Attendant is turned on, you cannot delete a menu that is 

referenced by a period. If you attempt to delete a referenced menu, a pop-
up will indicate which of your period(s) use this menu. You will need to change 
the menu associated with these schedule period(s) before you can delete the 
menu you have currently chosen to delete.

Keys Tab

You should use the Keys tab to specify what should happen when a caller selects a 
particular option from your menu.

Step 1 - Navigate to the Keys tab by clicking on the Menu tab in Premium Attendant 
(as described above).

Step 2 - Ensure that the correct menu is selected on the left-hand side of the screen.

Step 3 - Configure the options that you want to offer to your callers on the selected 
menu.

 ◦ The screen lists the keys 1-9, 0, # and *. Alongside each key, you will see a drop-
down box, which you can use to select what will happen when a caller presses 
that key on their phone whilst in this particular menu. For each option that you 
wish to offer your callers, decide which key they will press to access it, and 
select the appropriate option from the corresponding drop-down. For example, 
if you want to play an announcement describing your opening hours when a 
caller presses 1, you would assign key 1 to ‘Announcement-return’.

 ◦ Choosing an action from the drop-down box dynamically brings up any details 
that need to be completed in the next column: in the above example, you 
would need to enter the name of the announcement to be used.

 ◦ The screen will use an icon alongside a key assignment to indicate if there are 
any configuration errors, for example because an announcement is missing 
audio.

 ◦ For each key you can choose from the following options...
 ▪ ‘Use default’. If a caller presses this key, they experience the global  

key configuration for this event (set using the Advanced tab). This option 
is selected by default for all keys on new menus. If you select this option 
for a key, the default value will be shown in the next column as a link to 
the Default keys page on the Advanced Settings page. You can change 
the default behavior of these keys as described in Advanced Settings . If 
the default value is ‘Do Nothing’, a caller will be told that the option is not 
recognized if they press this key.

 ▪ ‘Transfer to Phone’. If a caller presses this key, they are transferred to a 
phone number of your choice. For example, you might want to allow callers 
to “press 4 to speak to a sales representative”. You must also enter the 
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phone number you wish to transfer to in the box that will appear to the right 
of the drop-down. Enter the phone number exactly as you would dial it from 
a phone.

 ▪ ‘Transfer to Voicemail’. If a caller presses this key, they will be transferred 
directly to a voice mailbox of your choice and invited to leave a message. 
For example, you might want to allow callers to “press 5 to leave a message 
for one of our sales team”. You must also enter the phone number of the 
mailbox you wish to transfer to in the box that will appear to the right of the 
dropdown. The number you enter must be the 10 digit phone number of a 
mailbox on this system.

 ▪ ‘Dial by Extension’. If a caller presses this key, they can choose who they 
want to speak to within your organization by dialing an extension number. If 
you assign a key to Dial by Extension, you must also do the following.
 ▫ Define the set of extensions that your callers can enter and the phone 

numbers that each will transfer to. Note: do not attempt to do this 
until you have finished configuring your menu, and have applied your 
changes in step 4.

 ▪ ‘Dial by Name’. If a caller presses this key, they can choose who they want 
to speak to within your organization by dialing their name. If you assign a 
key to Dial by Name, you must also do both of the following.
 ▫ Define the set of extensions that your callers can enter, their names and 

the phone numbers that each will transfer to. Note: do not attempt to 
do this until you have finished configuring your menu, and have applied 
your changes in step 4.

 ▫ Give your callers suitable instructions as part of your menu 
announcement. For example, if you assign key 4 to Dial by Name, then 
your menu announcement should include wording similar to: “if you 
know the name of the person you require, press 4, and then enter the 
name followed by the pound key.”

 ▪ ‘Voicemail by Extension’. If a caller presses this key, after entering the 
required extension number, they are transferred directly to a MetaSphere 
mailbox without ringing the subscriber’s phone. You will see a pop-up if 
you enter a number that doesn’t have a mailbox. If you assign a key to 
Voicemail by Extension, you must also do both of the following.
 ▫ Define the set of extensions that your callers can enter and the phone 

numbers that each will transfer to. Note: do not attempt to do this 
until you have finished configuring your menu, and have applied your 
changes in step 4.

 ▫ Give your callers suitable instructions as part of your menu 
announcement. For example, if you assign key 4 to Voicemail by 
Extension, then your menu announcement should include wording similar 
to: “if you know the extension of the person you wish to leave a message 
for, press 4, and then enter the extension followed by the pound key.”

 ▪ ‘Voicemail by Name’. If a caller presses this key, after entering the required 
name, they are transferred directly to a MetaSphere mailbox without ringing 
the subscriber’s phone. You will see a pop-up if you enter a name that 
doesn’t have a mailbox. If you assign a key to Voicemail by Name, you must 
also do both of the following.
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 ▫ Define the set of extensions that your callers can enter, their names and 
the phone numbers that each will transfer to. Note: do not attempt to 
do this until you have finished configuring your menu, and have applied 
your changes in step 4.

 ▫ Give your callers suitable instructions as part of the announcement. 
For example, if you assign key 4 to Voicemail by Name, then your 
announcement should include wording similar to: “if you know the name 
of the person you wish to leave a message for, press 4, and then enter 
the name followed by the pound key.”

 ▪ ‘Selfcare by Extension’. If a caller presses this key, after entering the required 
extension number, they are transferred directly to selfcare. If you assign a 
key to Selfcare by Extension, you must also do both of the following.
 ▫ Define the set of extensions that your callers can enter and the phone 

numbers that each will transfer to. Note: do not attempt to do this 
until you have finished configuring your menu, and have applied your 
changes in step 4.

 ▫ Give your callers suitable instructions as part of your menu 
announcement. For example, if you assign key 5 to Selfcare by Extension, 
then your menu announcement should include wording similar to: “to 
transfer to selfcare, press 5, and then enter your extension followed by 
the pound key.”

 ▪ ‘Intercept Mailbox’. If a caller presses this key, they are transferred to the 
mailbox configured globally for Premium Attendant. The telephone number 
for this mailbox is configured using the Advanced, Other Settings tab.

 ▪ ‘Go to Menu’. If a caller presses this key, they are transferred to another 
Premium Attendant menu. You should select the menu from the dropdown 
box or choose ‘create new menu’, entering a unique name and description 
for this menu in the pop-up that will appear. If you subsequently delete the 
menu linked to on this key, the dropdown will display ‘Select menu’ and the 
key action will be marked with an error.

 ▪ ‘Return to Previous Menu’. If a caller presses this key, they are returned 
to the previous menu. If there is no ‘previous menu’ to return to, Premium 
Attendant will simply replay the current menu.

 ▪ ‘Replay Menu’. If a caller presses this key, Premium Attendant replays the 
current menu.

 ▪ ‘Announcement - Return’. If the caller presses this key, they will hear an 
announcement and then be returned to the menu. You should use the drop 
down box to select the announcement to use, or create a new one.

 ▪ ‘Announcement Hang-up’. If the caller presses this key, they will hear an 
announcement and Premium Attendant will then hang up the call. You 
should use the drop down box to select the announcement to use, or 
create a new one.

 ▪ ‘Hang-up’. If a caller presses this key, Premium Attendant hangs up the call 
without playing an announcement.

Step 4 - Apply the changes you have made to your menu configuration by pressing 
the ‘Apply’ button at the bottom of the screen.
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After you have set up your menu configuration, you can change it at any time by 
reassigning keys or updating announcements. If you change the options that you offer 
to your callers, remember to re-record your opening announcement as well!

Timeout Options

If you want to change the timeout behavior on an individual menu, use the Timeout 
tab to override the default timeout behavior for all your Premium Attendant menus 
(set under the Advanced tab).

• Navigate to the Timeout tab by clicking on the Menu tab in Premium Attendant.
• Select the menu from the list on the left-hand side.
• Set the new timeout duration in the drop-down box. You can enter any value 

between 0 and 10.
• Specify the action to be taken if a caller fails to press a key or to select a valid 

extension or name to transfer to within this time.

References

The References tab shows which menus and schedule periods make reference to the 
menu currently selected on the left-hand side.

To check if a menu is referred to by another menu or schedule:

• Navigate to the References tab by clicking on the Menu tab in Premium 
Attendant.

• Select the menu you want to check the references for.
• You will then see a list of all the menus and schedule periods that use this menu. 

You can click on these links to go to these menus and schedules, for example if you 
want to change the menu that these reference.

• If there are no references, you will see the message ‘This menu is not referenced’.

This feature is useful if you want to delete a menu, as you can only do this if the menu 
is not referenced by any menus or schedule periods.

Premium Attendant Menu Announcements

The Announcements tab lists all the announcements that you have already created 
when setting up your menu configuration, and uses icons to indicate the status of 
each one. As this list can be up to 300 items long, you can use the search box to find 
the announcement(s) you wish to work with, by typing in all or part of either the name 
or description, or using the recording ID number.

Note that the list of announcements contains only those for which the recording can 
be changed. There are also system announcements, for instance the announcement 
played when the user presses an invalid key, that cannot be changed or listened to 
via the web interface.
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The icons on the left hand side are used as follows:

•        indicates that a recording exists for this announcement. Clicking on the icon 
plays the announcement.

•        indicates that a recording does not exist for this announcement.
 
The icons on the right hand side indicate the following states:

•       the announcement is referenced by one or more menus.
•       the announcement is not referenced by a menu.
•       the announcement is referenced by a menu but does not have a recording.

To create a new announcement:

• Click on the ‘Add new announcement’ button.
• Enter a unique name and description in the pop-up overlay that will appear.
• This will also launch the Recording overlay to enable you to record the 

announcement. You can either do that now following the instructions in Recording 
announcements or close the overlay and record the announcement at a later 
stage.

To delete an announcement:

• Select it by ticking the checkbox on the far left-hand side of the announcement.
• Press ‘Delete’.
• You can use the checkbox in the title bar to select all the announcements if you 

wish to delete them all. Note that if you tick the checkbox in the title bar, and then 
do a search to filter the announcements list and then press ‘Delete’, you will delete 
all the announcements and not just those shown.

• If you attempt to delete an announcement that is still referenced by a menu, you 
will see a warning pop-up asking you to confirm or cancel the operation.

• You cannot delete a menu announcement if this menu is used by any of your 
schedule periods. In this case, Premium Attendant will display a pop-up to indicate 
this and the selected announcement(s) will not be deleted.

You can use the ‘Download recording report’ button to generate a CSV format list 
of all your announcements that will show the number, name and description of each 
announcement, plus whether audio is present and whether it is referenced by an 
existing menu. This process may take several minutes if you have a large number of 
announcements.

Clicking on any part of the details for an announcement on this page brings up the 
recording overlay.
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Recording Premium Attendant Announcements

When using Premium Attendant, all messages that are played to your callers must be 
recorded by you in advance. See configuring your Premium Attendant menus.

Premium Attendant offers two ways to record your messages.

• If your computer has a sound card and microphone, you can use these to record 
your messages directly from the Premium Attendant configuration pages.

• Alternatively, if you do not have the necessary equipment (or if you simply prefer), 
you can record your messages using your telephone.

Recording Messages Directly From Your Computer

Anywhere you see      record you can click on the icon to bring up the announcement 
recording control. This allows you to record your message directly via your computer’s 
microphone.

Once you have recorded a message, the      record will change to      listen/change. 
Clicking on this icon will again bring up the announcement recording control, which 
will enable you to play back, and if you wish, overwrite your recording.

Recording Overlay

You can use the recording overlay to edit the name and description of the 
announcement as well as record the audio message and download a recorded one.

The recording overlay has three tabs that can be opened using the XX icon - opening 
one automatically closes the other tab. These tabs allow to you...

• record the audio for an announcement or, if a recording has already been made, 
listen to the announcement.

• download an announcement, if it was already recorded or uploaded.
• upload a recording - this will show the current filename and duration if audio 

already exists for this announcement. You should use the ‘Browse’ button to find 
required file, select it and then click on ‘upload’ to upload it. You will see an error 
message if the file is not in a supported codec or if it is invalid. Supported codecs 
are G711 WAV (8-bit, ulaw / alaw, mono, 8kHz), 16-bit PCM WAV (16-bit, PCM, 
mono, 16kHz).

• record by phone - this tab gives brief information on how to use the self-care TUI to 
add audio to this announcement.
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Recording a message

A number of controls are provided for recording your message.
 
•       Starts recording. This will overwrite any message you have previously recorded.
•       Stops recording the message.
•       Plays back your recorded message. This action will be unavailable if you have 

not yet recorded a message.
•       Stops playing the message.
•       This control allows you to adjust the gain of your microphone. Click and 

then adjust the slider    to set the required volume level. While recording, the              
lights above this control will show how loud the signal is from your microphone. 
If the gain is set correctly then several green lights should appear while you are 
recording. If only one or two appear, then the gain is set too low and your message 
will be too quiet. If red lights appear then the gain is set too high and your message 
will be distorted. 

•       This control allows you to adjust the playback volume. Click and then adjust the 
slider    to set the required volume level.

•  Th is control allows you to view and change your Adobe Flash Player Settings, for 
example to adjust the settings for your microphone.

When you first attempt to record a message, an “Adobe Flash Player Settings” overlay 
will appear. Ensure that the “Allow” radio button is selected, and if you do not wish to 
be shown these settings in future tick the “Remember” checkbox.

To record a message you need to carry out the following steps.

• When you are ready to record your message, press the       button.
• Read your message into your microphone, and when you have finished, press the 

button.
• Playback your message to check that it has recorded correctly by pressing 

the       button. If you want to stop the playback, press      . If there is a problem 
with the recording, e.g. you cannot hear it, or it is very quiet, see the section on 
troubleshooting below.

• If you are not happy with your message content, then record a new message by 
pressing the record button again. This will overwrite your previous message.

Troubleshooting

I have recorded my message, but when I try to play it back I cannot hear anything

• Check you have actually recorded something. The length of the current recording 
is shown as e.g. 0:01:35 (1 minute and 35 seconds). If the current recording length is 
0 or much lower than expected then try recording your message again.

• Check that playback volume is turned up high enough. Volume can be adjusted 
using the volume slider described above.

• Try re-recording the message, and as you are recording, watch the lights               
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on the player.
 ◦ If no lights appear, or only one or two appear, then check the following.

 ▪ Increase the gain of your microphone by clicking       and moving the gain 
control    nearer to the top end.

 ▪ Click the       icon to bring up the “Adobe Flash Player Settings” and make 
sure that the Allow option is selected. Click on the microphone icon at 
the bottom of this settings box and check that the correct microphone is 
selected in the dropdown, and that the record volume is turned up.

 ▪ If you are using an external microphone, check that this is plugged in 
correctly.

 ◦ If this still doesn’t solve the problem, then it may be that your microphone has 
been muted by the operating system (e.g. Windows) - refer to your operating 
system help for further information.

• If several green lights appear consistently while recording your message, then it is 
likely that your message has recorded correctly and the problem is occurring when 
playing it back. If you are using external speakers, check that these are plugged 
in correctly and turned on. If this does not resolve the problem, then it may be that 
your speaker has been muted by the operating system (e.g. Windows) - refer to 
your operating system help for further information.

I have recorded my message, but when I try to play it back it is distorted

This may be because your microphone gain is set too high. Reduce the gain by 
clicking  and moving the gain control  nearer to the bottom.

Recording Messages Using Your Telephone

If you wish to record your initial greeting and announcements using a telephone:

• Follow the instructions above for setting up your Premium Attendant menu, but 
don’t click on any of the       record icons that appear.

• Once you have configured your menu options, press ‘Apply’ as usual to save your 
changes. You will be warned that you have not yet recorded an initial greeting, 
and if you have assigned any keys to ‘Play announcement’, you will also be 
warned that you have not recorded the announcements to play. Ignore this 
warning.

• Dial your Premium Attendant service access number from your telephone, and 
select the appropriate options from the menu you will hear. You will be given the 
opportunity to record your initial greeting, as well as the announcements for any 
‘Play announcement’ keys you have set up.

Note: if you wish to offer your callers the option to listen to announcements in your 
Premium Attendant menu, you must use the Web interface to assign the appropriate 
keys to ‘Play announcement’ before you can turn on your Premium Attendant.
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Configuring the extensions callers can dial

If you have chosen to offer your callers a Dial by Extension, Dial by Name, Voicemail 
by Extension, Voicemail by Name or Selfcare by Extension option, then you can 
configure the set of extensions they can dial in the following two ways. You can 
configure up to 200 extension numbers.

Business Group Extensions

Business Group extensions are the list of lines within your Business Group. A list of all 
extensions in your Business Group is displayed in the “Business Group Extensions” tab. 
Additional numbers are only displayed if an extension has been configured (the main 
number is always included). You can configure which extensions are exposed to 
callers as follows:

• For each extension, you can select whether or not to include it in the list available 
to callers.

• Any new lines added to the Business Group will automatically be included in or 
excluded from the set available to callers, based on the “Automatically include 
new extensions as they are added to the Business Group” setting.

Lines available within the Business Group which are available to callers appear in bold. 
Any available line will automatically be available to any Dial by Extension, Dial by 
Name, Voicemail by Extension, Voicemail by Name or Selfcare by Extension actions.

To include selected lines in Dial by Name or Voicemail by Name actions, you need to 
make sure that a name recording is available for that line. The name recording can 
come from one of two places:

• You may record or upload a name recording by clicking on the “record” link for 
the line.

• If the line already has a name recorded for voicemail, then this can be used as the 
name recording for callers.

Lines with no name recorded have a red “record” link displayed which allows you to 
record a Business Group name recording for that line.

Lines using the voicemail spoken name have a green “override” link displayed. This 
link allows you to record a Business Group name recording for the line to be used in 
preference to the voicemail name recording.

Lines with a Business Group spoken name recorded have a green “listen/change” link 
displayed, allowing you to listen to your current recording and delete it or replace it 
with a new recording.

If a given line has both name recordings available, then the one you have recorded 
for use in this business group will be used in preference.
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Lines that cannot have a recording, for example any additional numbers configured 
on a mailbox, will not have a speaker icon.

Additional numbers for a mailbox cannot be used for Dial by Name actions unless the 
additional number is attached to an undialable secondary group mailbox of the form 
number-X, AND both the undialable number and additional number are included in 
the list. A caller entering the name of the subscriber will be put through to one of the 
subscriber’s additional numbers, and will be played the primary device’s recorded 
spoken name. If the primary device is marked as excluded, then the subscriber is 
excluded from Dial by Name actions even if there is an additional number marked as 
included.

Additional Extensions

To use additional extensions, you must define the set of extensions that callers can dial. 
For each extension you must specify the extension number (a short number of your 
choice, such as 107), the extension’s name and the phone number that your caller 
should be transferred to if they dial this extension.

• To configure your extensions click on the Extensions tab at the top of the Premium 
Attendant page , then click on “Additional Extensions”.

• To add a new extension, click the ‘Add Extension’ button. You will then be 
prompted for the following.
 ◦ Extension. This is the extension number that your callers will dial. It can be any 

number of your choice between one and seven digits long. It must not be the 
same as any other extensions you have already configured.

 ◦ Name. This is the name that your callers will dial. Both the first and last name 
must contain at least 2 dialable characters. You will also be prompted to 
record a spoken name for this extension by recording or uploading a name 
recording by clicking on the ‘Record’ link. This is played to callers if they enter 
a name that is not unique to allow them to refine their search. For example, 
if there are two extensions called “John” and the caller enters “John”, they 
hear the full names of both the extensions and can choose between them. 
Extensions that don’t have a spoken name recorded can’t be reached by Dial 
by Name or Voicemail by Name options. Refer to the section “ Recording an 
announcement “ for more information on recording spoken names.

• Telephone Number. This is the number that callers will be transferred to if they dial 
this extension. Enter the phone number exactly as you would dial it from a phone 
(although note that business group short codes and extension codes are not 
permitted).

• To edit the details for an existing extension, find it in the list on the left-hand side and 
select it. If you have a large number of extensions, you can use the search box to 
find the extension you wish to edit.

• To delete existing extensions, select the check box alongside the extension you 
wish to delete, and then press the “Delete Selected” button.
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Configuring the “Dial Extension at any time” option

In the Extensions tab (and on its subtabs if present), a link just above the button bar in 
the bottom of the page allows you to configure whether callers are allowed to dial by 
extension at any time or only after selecting a “Dial by Extension” menu option.

The link will reflect the current selected option, and by clicking on it, a popup will be 
displayed to allow the user to toggle between the options.

WARNING: Enabling this feature will mean that callers to the TUI will not be able to 
navigate through several menus at once by entering multiple keys.

Premium Attendant Advanced Settings

The Advanced tab allows you to configure the following settings for your Premium 
Attendant that will apply whenever you select a default value.

Default Keys

You can use the Default keys tab to configure the default action for the keys on the 
telephone. This determines what each key will do if it is set to ‘Use default’ in any of 
your Premium Attendant menus.

You can modify the global behavior of the keys 1-9, 0, # and *. Each of them can 
take the following values. With the exception of ‘Do Nothing’, all these values are 
described in Configuring your Premium Attendant menu(s).

To change the existing default value for a key, select one of the following from the 
drop-down box alongside the key:

• ‘Do Nothing’ - if a caller presses a key that has this value, they will be told that the 
option is not recognized.

• ‘Transfer to Phone’
• ‘Transfer to Voicemail’
• ‘Intercept Mailbox’
• ‘Dial by Extension’
• ‘Return to Previous Menu’
• ‘Replay Menu’

Error Handling

You can change the following global settings that determine what happens when 
there is an error when your callers are using Premium Attendant.

• Timeout duration (in seconds). This defines the behavior of Premium Attendant if a 
caller fails to press a key within the specified time.
 ◦ Enter the time in seconds within which a caller should press a key (you can use 



17

Premium Auto Attendant User Guide

any value between 0 and 10).
 ◦ Enter the number of failures (up to 4) permitted before Premium Attendant 

performs the action set in the box below. After each attempt, a system prompt 
is played informing the caller that the option is not recognized.

 ◦ Using the drop-down box, select the action that Premium Attendant will take 
once the caller has failed to press a key the specified number of times. Valid 
values are listed below.

• Unknown input. This defines the behavior of Premium Attendant if a caller press a 
key that has not been assigned an action.
 ◦ Enter the number of failures (up to 4) permitted before Premium Attendant 

performs the action set in the box below. After each attempt, a system prompt 
is played informing the caller that the option is not recognized.

 ◦ Using the drop-down box, select the action that Premium Attendant will take 
once the caller has pressed an invalid key the specified number of times. Valid 
values are listed below. If you choose “Announcement - Hang up”, you will be 
prompted to select the announcement that should be played.

• Failed attended call transfers. This defines the behavior of Premium Attendant if a 
call transfer fails to be connected.
 ◦ Using the drop-down box, select the action that Premium Attendant will take if 

the call transfer fails initially.
 ◦ Enter the number of failures (up to 4) permitted before Premium Attendant 

performs the action set in the box below.
 ◦ Using the drop-down box, select the action that Premium Attendant will take 

once the call transfer has failed the specified number of times. Valid values 
are listed below. An additional input box will appear if the action requires it, for 
example you will be prompted to enter a phone number if you select ‘Transfer 
to Phone’.

• Invalid extensions. This determines the behavior of Premium Attendant if a caller 
presses an extension number that it does not recognize.
 ◦ Enter the number of failures (up to 4) permitted before Premium Attendant 

performs the action set in the box below.
 ◦ Using the drop-down box, select the action that Premium Attendant will take 

after the specified number of failures to connect to a valid extension. Valid 
values are listed below. An additional input box will appear if the action requires 
it, for example you will be prompted to enter a phone number if you select 
‘Transfer to Phone’.

The following actions can be selected for the above default settings.

• ‘System Announcement then Hang up’ - although you can only use action this for 
timeout and unknown input settings

• ‘Transfer to Phone’
• ‘Transfer to Voicemail’
• ‘Intercept mailbox’
• ‘Replay Current Menu’
• ‘Announcement - Hang up’
• ‘Hang up’
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You will see an error icon next to the misconfigured event if you have made any errors 
in changing the default configuration for your Premium Attendant.

Other Settings tab

The Other Settings tab allows you to...

• set whether Dial by Name or Voicemail by Name key presses match on First and 
last name (default), or just first name or just last name.

• set the number for the mailbox to be used on the Intercept Mailbox action. This 
number will be used by every Premium Attendant menu that uses this option on 
a key. Error message pop-up if this number doesn’t correspond to a MetaSphere 
voicemail account.

Turning Premium Attendant on/off

To turn your Premium Attendant on or off, navigate to the Main tab at the top of the 
Premium Attendant page, and click on the button labeled Turn ON or Turn OFF on the 
Activation status panel.

When your Premium Attendant is turned off, callers will either be played an 
announcement telling them that the number is unreachable, or forwarded to a 
number of your choice. Many users will leave their Premium Attendant turned on all 
of the time, but (depending upon how Premium Attendant has been deployed) you 
may, for example, wish to turn Premium Attendant off during the day and forward your 
callers directly to a live receptionist instead.

Forwarding calls when Premium Attendant is turned off

When your Premium Attendant is turned off, you can choose either for callers to...

• be played a message telling them that the number is unreachable
• be forwarded to an alternative number.

To change this setting, your Premium Attendant must first be turned off. The text at the 
top of the Main Premium Attendant tab will then read either “Your Premium Attendant 
is currently OFF and callers will be told that this number is unreachable”, or “Your 
Premium Attendant is currently OFF and callers are being forwarded to < number >”. 
To change the current setting, click on the link included in this message.

Still Need Assistance?

Visit www.powernetco.com/cloudphonesupport for additional documentation.
For more information contact our Service Management team at 866.201.1300.

For technical support call 321.214.2222 or email support@powernetco.com. 
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